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1. Describe the importance of testing

2. Compare the types of tests

3. Creating unit tests

Objectives
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2. Mobile specific issues

3. Outside-in vs. Inside-out testing

Tasks



❖ We must test our applications to 

ensure high quality and that they do 

what they are supposed to do in all 

cases

Importance of testing



Traditional testing

❖ Traditional testing has people 

perform limited or superficial testing 

on a device

❖ The thoroughness of this style of 

testing depends on the skill of the 

tester

❖ Easy to miss new problems 

introduced in other areas of our 

programs we did not expect



Automated testing

❖ As the number of features and 

devices grows, it becomes 

impractical to manually test our 

applications 

❖ Instead, we can automate our 

testing to make sure that we test 

not just the new things being 

added, but also the existing feature 

set to make sure we have not 

changed the expected behavior



❖ Mobile applications have unique challenges that can be difficult to test 

manually

Mobile-specific issues

Fragmentation Different Devices

Constant 

day-to-day use

Network 

Connectivity

Service Availability



❖ There are two different automated testing approaches commonly used

Testing approaches

Inside-out

Testing

Outside-in

Testing

The approach you take determines where you start testing



❖ Inside-out testing, commonly 

known as unit testing, performs 

tests on the individual classes and 

functions of the application 

independent of the UI

Inside-out testing

Model

• Model Classes

Business Layer

• Supporting Classes

Service Layers

• Testing or Simulating Service Access

User Interface

• View Model classes

• User Interface Testing

Specifications



❖ Unit tests check the smallest units of work to ensure they behave as 

expected

Example of inside-out testing

var original = "1-855-XAMARIN";
var expected = "1-855-9262746";

var actual = PhonewordTranslator.ToNumber(original);

Assert.AreEqual(expected, actual,
"The expected phone numbers are not equivalent");

Testing a single method on an applications class



❖ Outside-in testing, also known as 

acceptance testing, checks that the 

final application as a whole 

conforms to the specification

Outside-in testing

Model

• Model Classes

Business Layer

• Supporting Classes

Service Layers

• Testing or Simulating Service Access

User Interface

• View Model classes

• User Interface Testing

Specifications



Example of outside-in testing

Feature: Manage the management of tasks

Scenario: Delete an existing task

Given I am on the Task Details screen for the ”Get Milk" task

When I press the Delete button

Then I should be on the TaskyPro screen

And I should not see the "Get Milk" task in the list

When /^I press the Delete button$/ do
tap("button text:'Delete'")

end



❖ Both approaches have their purpose, often want to perform both styles 

of testing in your overall testing plan

Inside-out vs. outside-in

Inside-Out Testing Outside-In Testing

Allows you to test for intricate aspects 

of the system

Allows you to test the UI, which is what the 

application will be signed-off on

The UI is often not tested at all Does not test unexpected error and edge 

cases and can often miss internal behavior



Flash Quiz



① What are some of the issues with testing mobile apps (choose all that 

apply)

a) Fragmentation

b) Network Connectivity

c) Access to Services

d) Interruptions

Flash Quiz
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② Outside-in testing refers to

a) Testing the application outside using Wifi then going indoors

b) Testing the actual features of an application

c) Testing that the user interface looks right

Flash Quiz
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1. Importance of testing

2. Mobile specific issues

3. Outside-in vs. Inside-out testing

Summary



Compare the types of tests



1. Types of tests

2. Understanding the tests

Tasks



❖ There are many 

types of testing you 

can perform on 

your code

❖ # of tests should 

increase the further 

down the pyramid 

you go

Types of Tests



❖ A unit test takes a small unit of the application (typically a method), 

isolates it from the remainder of the code, and verifies that it behaves 

exactly as expected

What is a unit test?

CalculateTip()

15% tip results in proper total

20% tip results in proper total

Negative tip results in exception

…

Possible Calculate Tip unit tests

Here, we will test just this single 

method to calculate a tip –

notice that we have multiple 

tests to try different inputs and 

outputs



❖ A component/module test validates isolated modules (objects, classes, 

etc.) as a whole with external dependencies simulated/stubbed out

What is a component test?

Calculator

Add two numbers

Subtract a number

Divide by 2

Validate final result

Possible Calculator component tests

Component tests would test the Calculator class as a whole, executing multiple 

methods to check state management and proper totals

Add

Subtract

...



❖ Integration tests verify that classes work together as expected

What is an integration test?

Student Course

Add Student to course, shows up in roster

Student has proper pre-requisites

Total # of students incremented

Max # students not exceeded

...

Possible Enrollment integration testsHere, we will want to test both

the Student class and the 

Course classes together to 

verify the combination



❖ Acceptance tests ensure that the finished product conforms to original 

designs and/or specification and is fit for the purpose it is intended

What is an acceptance test?

Specifications

Acceptance Tests



❖ UI Testing validates the application by interacting with the UI and using 

the app like the typical user

❖ This is often done manually by the QA group (at great time + expense)

What is a UI test?



Understanding the Tests

"You would have unit tests for individual classes in the domain and database 

mapping layers. In most of these unit tests, you might not even connect the database. 

You would stub the database out.”

"Acceptance tests view the system more as a black box and test more end to end 

across the whole system”.

"But with the functional (acceptance) tests, which go end to end, 

you would want everything connected.”

− Martin Fowler
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① A test that tests a single piece of isolated functionality (e.g. a method or 

property) is a _________. 

a) Unit test

b) Regression test

c) Integration test

d) Acceptance test
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② If Bill wants to make sure that his new class works well with Susan's 

existing class, he should write a(n) _______.

a) Unit test

b) Regression test

c) Integration test

d) Acceptance test

Flash Quiz
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1. Types of tests

2. Understanding the tests

Summary



Creating unit tests



1. Unit Testing Benefits

2. Testing Frameworks

3. Writing test classes

4. Validating conditions

5. Running your tests

Tasks



❖ Testing can improve app quality and reduce development costs

Benefits of Unit Tests

Reduces bugs Adds documentation Improves your 

design

Reduce the overall 

cost of change



The cost of not testing

❖ “… the cost to fix an error found after product release was four to five 

times as much as one uncovered during design, and up to 100 times 

more than one identified in the maintenance phase.”

http://blog.celerity.com/the-true-cost-of-a-software-bug

COST OF A SOFTWARE BUG

$100 $1,500 $10,000
If found in Gathering 

Requirements phase

If found in QA Testing 

phase

If found in Production



The cost of not testing: reputation



❖ A Unit Test should be:

▪ Isolated and focused

▪ Self contained

▪ Independent

▪ Fast

▪ Repeatable

▪ Maintainable

Unit test requirements



❖ Unit Testing is almost always done 

with a unit testing framework

▪ Visual Studio for Mac uses 

NUnit

▪ Visual Studio on Windows uses 

MSTest, but can handle several 

others

Testing Frameworks



❖ There are several useful debugging 

features in Visual Studio for Mac 

that you should enable

▪ From the Menu

View > Unit Testing

View > Pads > Unit Tests

▪ Preferences
Text Editor > Source Analysis

Visual Studio for Mac Integration



❖ Visual Studio uses MSTest, but you can add NUnit as a test execution 

engine via NuGet or through the Tools > Extensions and Updates dialog

Visual Studio Integration



❖ Several project types are included with Visual Studio

Creating a Test Project

Creates a Xamarin.UITest project 

which is used to perform 

automated acceptance tests, 

there are versions for cross-

platform, iOS-specific and 

Android-specific.

XTC102 covers this in detail



❖ Several project types are included with Visual Studio

Creating a Unit Test Project

This creates a desktop NUnit test 

project that uses the full 

Mono/.NET technology stack. This 

is a good project to test code 

which is shared between your 

platform projects.



❖ Test classes contain test methods identified using attributes

Writing test classes

[TestFixture]
public class PertTests
{

[Test]
public void PertTest_CheckForEquality_ShouldBeTrue ()
{

// Unit Test goes here
}
...

}



❖ Test simplest thing possible (unit)

▪ Simple != Simplistic

❖ Test behaviors not methods

▪ Very common to have several unit 

tests for a single method

❖ If the tests are hard to write …

▪ Requirements may be too vague

▪ Can indicate problems in the design

Writing unit tests



❖ Unit tests should focus on a single aspect of the system under test to 

validate that it works as intended; use separate tests for other variations

Unit test = test one thing



❖ Useful to use a naming convention to more easily identify its purpose

▪ System under test (SUT)

▪ What is being tested

▪ Expected result

Naming your unit tests

TableSource_DataIsNull_ShouldThrowException()

PertTest_CheckForEquality_ShouldBeTrue ()

TestCountProperty()



❖ Unit tests typically have three steps:

What does a unit test look like?

public void PertTest_CheckForEquality_ShouldBeTrue()
{

double likelyAmount = 20;
double bestCaseAmount = 12;
double worstCaseAmount = 40;
double expectedResult = 22;

double actualAmount = Calculations.Estimate(
likelyAmount, bestCaseAmount, worstCaseAmount);

Assert.AreEqual (expectedResult, actualAmount);
}

① Arrange

② Act

③ Assert



❖ Use the Assert class to verify results; a test fails if any assert fails or if 

the method throws an unexpected exception

Validating conditions

[Test]
public void PertTest_CheckForEquality_ShouldBeTrue ()
{

// Arrange (setup test)
...

// Act (perform test)
...

// Assert (verify test)
Assert.AreEqual (expectedResult, actualAmount);

}



❖ The Assert class has several validation methods

Assertion types

AreEqual Contains Greater

AreNotEqual AreSame GreaterOrEqual

IsTrue AreNotSame Less

IsFalse IsInstanceOfType LessOrEqual

IsNotNull IsAssignableFrom IsNaN

IsEmpty IsNotAssignableFrom That

These methods are the ones you will use most often



Creating unit tests

Demonstration



❖ Test edge cases: code you expect to execute rarely or only during failure 

conditions

Testing exceptional conditions

[Test]
[ExpectedException(typeof(ArgumentNullException))]
public void Adapter_IfPassedNull_ThrowsException()
{

var adapter = new MyDataAdapter(null);
}

If the specified exception is not thrown by the test method, then the unit test will be 

marked as failed



❖ Better approach for exception testing is to use Assert.Throws or 

Assert.DoesNotThrow which take delegates to test

Testing exceptional conditions

[Test]
public void Adapter_IfArraySizePassedIsZero_ThrowsException()
{

Assert.Throws<ArgumentNullException>(() => {
// Test code goes here

})
}



❖ When using the .NET NUnit Library Project, the IDE includes support to 

run the tests through the Unit Tests pad and through test "bubbles"

Running your tests

Can click on 

bubbles next to 

test methods to 

run or debug a 

test, these change 

color based on last 

run result



❖ Can ignore tests using the [Ignore] attribute – useful if code has 

changed and the test has not been updated yet

Ignoring tests

[Test]
[Ignore("Fix this in V2")]
public void DESAlgo_Use128BitKey_Creates1024Cipher()
{
... 

}



❖ Alternatively, can add a "time-bomb" to make sure invalid tests get 

updated

Ignoring tests

[Test]
public void DESAlgo_Use128BitKey_Creates1024Cipher()
{

if (DateTime.Now > new Date(2015, 05, 30)) {
Assert.Fail("Fix this test");

}
return;
// Real test (not being run) follows 
...

}



❖ Common code can be refactored 

into either per-class or per-test

initialization using attributes on 

methods in the testing class

[TestFixtureSetUp]

[TestFixtureTearDown]

[SetUp]

[TearDown]

Initializing tests and test methods

TestFixtureSetUp

Run  Test #1

SetUp

TearDown

Run  Test #1

SetUp

TearDown

TestFixtureTearDown



Comparing MSTest and NUnit

MSTest NUnit

[TestClass] [TestFixture]

[TestMethod] [Test]

[ClassInitialize] [TestFixtureSetup]

[ClassCleanup] [TestFixtureTearDown]

[TestInitialize] [SetUp]

[TestCleanup] [TearDown]

[AssemblyInitialize] N/A

[AssemblyCleanUp] N/A
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① What are some aspects of unit tests (choose all that apply)

a) Arrange-Act-Assert

b) Unexpected exceptions cause the test to fail

c) Should always use the Assert.AreEqual operation

d) They should test integration and database connectivity

e) They should be as small and fast as possible
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② NUnitLite is: 

a) A framework for small applications

b) A framework for running tests on devices

c) A testing framework with fewer calories

Flash Quiz
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Creating unit, regression and integration tests

Individual Exercise



1. Unit Testing Benefits

2. Testing Frameworks

3. Writing test classes

4. Validating conditions

5. Running your tests

Tasks
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